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Grapevine 2.4 User’s Guide
What is Grapevine?
This program is a tool to help the administrators of live-action role-playing (LARP) games organize and maintain all the
information that goes with the job. Grapevine catalogues players’ contact information and character sheets, stores
descriptions of important game-world locations and items, and provides a framework upon which to build the flow of game
events and plot hooks.
LARP games are played by many rules sets in many genres, but the most ubiquitous by far is the Mind’s Eye Theater (MET)
system in the World of Darkness genre, published by White Wolf Game Studios. Grapevine is specifically designed for use in
conjunction with published MET materials. Administrators employing other systems or genres, however, may find many of
Grapevine’s features flexible enough to account for their needs as well.

Hold On – What’s a LARP?
A group of friends get together to take part in a fictional story. One person acts as moderator and director, determining the
events that guide the plot. Each other person controls the role of a character in the story. That’s the essence of a role-playing
game – part improvisational acting, part creative writing, and part childhood make-believe. Most often the players also agree
on a system of rules that helps describe the story and resolve conflicts in the context of the story.
The LARP game is a form of role-playing designed for large numbers of players, usually in the range of ten to a hundred. It
emphasizes fast and easy rules and minimal reliance on moderators or administrators. Unfortunately for the administrators in
question, that ‘minimal’ reliance still entails a great deal of paperwork between games – hence the need for Grapevine.

Program Features
Grapevine streamlines a Storyteller’s work by helping carry out some of his or her most common administrative tasks.


Character Sheets. Build a complete database of information on every character in your game. Menus of all published
MET material make assembly just a matter of point-and-click.



Player Information. Catalogue all your players’ contact information.



Experience Points. Maintain accurate experience totals and histories. Number-crunching becomes a minimal task.



Chronicle Tools. Control the flow of events and information in your game, from character actions like Influence use to
the rumors that eventually reach their ears.



Game World Information. Detail the items and locations in your game.



Printing and Exporting. Print character sheets, rumor sheets, player lists, and other reports. Export the information to
text, RTF, or HTML format.



Data Exchange. Share character, player, and chronicle information with other users of Grapevine.



Customizable Features. Edit Grapevine’s menus and output to suit the needs of your unique game.
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Program Requirements
Grapevine requires a PC running Windows 95 or later. It also requires its users to own and use one or more of White Wolf’s
MET rules books. Grapevine is not a character generator or a rules encyclopedia; while it can organize and manipulate game
data, it’s your job to assemble and use that data.

Your Grapevine Game File
Game files are stored with the .gv3 extension. Grapevine files with the .gex extension are used to exchange Grapevine data
with other users; they are discussed in this chapter under the heading “Data Exchange.”
Both kinds of files internally organize game data using either a proprietary binary format (the default) or Extensible Markup
Language (XML). Once you save a chronicle in a given format, it will stay in that way until you save it differently. The binary
format is smaller and faster, but the XML format is good for working with over the web.
Look under the File menu of the Grapevine window; here is where you’ll find the features that deal with the game file.

New Game
The New Game command under the File menu closes the current file and creates an empty game file. You can then start
entering game data from scratch. See “Setting up Your Game” for a good place to start. When you first start a new game, you
will immediately be taken into the Game Settings menu.
If you’ve been editing a different file prior to creating a new game, you may be prompted to save the changes you’ve made.

Open Game
The Open Game command summons a dialog box where you can browse your computer’s folders and find a Grapevine game
file. Selecting that file and clicking the Open button will load the game data into Grapevine and open the Characters Window
for you.
If you’ve been editing one file prior to opening another, you may be prompted to save your changes first.

Save Game
This command under the File menu stores your game data in a file on your hard drive. If you haven’t specified a file name for
your game yet, the “Save Game As...” window will appear.
A progress bar will appear at the bottom of the Grapevine screen and display the progress of the save. When the bar reaches
all the way to the right, it has finished saving.

Save Game As
Choosing “Save Game As...” will open a file window that allows you to locate a folder and choose or enter a filename. Clicking
“Save” will then save your data in the specified file. If the filename you’ve chosen already exists, you will be asked whether
you want to overwrite the old file. This will allow you to save your game in two different file formats: Grapevine Binary or
Grapevine XML. If you do not plan on using Grapevine on the web, save the game as a Binary file format (which is the default
setting).
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A progress bar will appear at the bottom of the Grapevine screen and display the progress of the save. When the bar reaches
all the way to the right, it has finished saving.

Data Exchange
This command makes a window appear that you can use to save and load selected portions of Grapevine data. Use these
“exchange files” to send information to other Grapevine users, or to load their data into your game.

Saving Selected Data
Ten tabs appear along the top of the window: Game Settings, Players, Characters, Items, Rotes, Locations, Actions, Plots,
Rumors, and Searches. The tab that is selected determines what is shown in the list below. The items in that list may each be
selected or deselected with a click of the mouse. Buttons that help in the selection process include:


Select All. Selects everything in the list.



Select None. Deselects everything in the list.



Select Only. For players and characters, this selects all data that is matched by the search selected in the dropdown
list below the button.



Select Associated. For players, this selects the characters associated with the players you’ve already selected. For
characters, it selects the associated players, items, rotes and locations. For chronicle data (actions, plots and rumors),
this will select the other chronicle data that they affect or are affected by.



Select Same Date. For actions and rumors, this selects the other actions or rumors that share a date with the
selections.



Select Same Name. Also for act ions and rumors, this selects the other actions or rumors that share a character name
or title with the selections.



Don’t Save text marked ST Only. This checkbox, if selected, edits out all text you’ve placed between the [ST] and [/ST]
tags (or whatever you specify in your Game Options). Select this if you’re preparing an exchange file for a player.

Selections are preserved as you navigate from tab to tab. When you’ve selected everything you want to save, click the Save
button. A window will appear where you can specify a filename. Everything you selected, but no other information, will be
saved to that file. Other Grapevine users can then use Data Exchange to load that data into their game files.
This is a good way to send your players their character information or to coordinate responsibility for writing rumors amongst
your Narrators.

Loading Data
Click the Load button and you’ll get a window from which you can choose a Grapevine exchange file to load. The information
from that file will be imported into your game. If the danger of overwriting old information exists, you will be prompted for
the action to take.

Merge
This option allows you to combine the contents of another Grapevine file with the file you’re working on.
Choose it and a window appears from which you select the Grapevine game file that you want to merge in.
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If the two files contain any duplicate information, the merge feature will automatically choose to overwrite old data with new
data, based on their internal timestamps. Be careful!

Recent Files
A numbered list of files you’ve recently worked with in Grapevine appears near the bottom of the File menu. Choosing one
will automatically load the listed file. If you’ve been working on one file already, you may be prompted to save your work first.

Setting up your Game Information
The Game menu lists the features you can use to give a number of specifics about your game, including the title of your
Chronicle, a schedule of game sessions and the Grapevine settings to use with this information.

Game Information
The game information tab of the game settings window offers you fields in which to record a basic outline of your game.


Chronicle Title. This will be displayed in Grapevine’s title bar when you’re working on the file.



Web Page. Grapevine can link you instantly with your game’s web presence.



E-Mail. How to get in touch with this game by e-mail.



Phone. How to get in touch with this game by phone.



Staff. This field automatically lists the chosen few not listed as “Player” in your Player Information.



Usual Place. Where to show up to play this game.



Usual Time. When to show up.



Description. Be it a few notes to yourself or a full-blown ‘venue style sheet,’ spare a few words to describe what
exactly this chronicle is all about.

Game Dates
A calendar on the Game Dates tab allows you to specify each date you plan a game session. Click any date to identify it as a
session. Time and Place, below the calendar, will automatically show the usual time and place you entered in Game
Information, but you can edit these to account for any changes.
Clicking the Delete Date button will eliminate the selected date from the game schedule. It will also delete all action and
rumor entries for that date (see the “Chronicle: Actions, Plots and Rumors” chapter). A confirmation dialog will appear to
ensure you want to go through with this. Unless you’re gung-ho about complete chronicle records, deleting old dates is
recommended every so often to keep your file size down.
Filling this schedule out is especially important if you want to use Grapevine’s Chronicle features. Chronicle organizes all
player actions, plot developments, and rumors by game date.
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General Settings
In the General Settings tab of the Game Settings window, you let Grapevine know what kind of general working environment
you’d like to use with this game file.


Health Levels. Older MET books allotted only four health levels to characters; Revised MET books allotted seven. This
option controls the number of health levels Grapevine gives characters by default. Most games use seven. The two
conversion buttons will help you convert all the characters in your game from one standard to another.



Enforce the use of Experience Point histories and Player Point histories. Checking this option will disable your ability
to alter experience and player points without making corresponding entries in their histories. You’ll have to track the
source and use of every experience point and player point. Leaving this option unchecked allows you to change point
totals freely without having to keep records.



Edit Physical, Social, and Mental Trait Maximums separately. By default, when you change one Trait Maximum on a
character sheet, the other two change as well. Enabling this option allows you to edit the three numbers individually.



Hide Storyteller Notes. By default, all text you save in Grapevine between the tags [ST] and [/ST] will never be printed
or saved to a character sheet or game report. It’s secret information that remains only within the Grapevine file. Here
you can change those tags from [ST] and [/ST] to whatever you want. To disable the feature, leave both fields blank.



Character Sheet Menus. Here you find listed the file Grapevine uses to populate its character sheet menus. Click the
“Browse...” button here to display the Grapevine Menus window and load a new Grapevine Menu (.gvm) file. (See
“Editing Character Sheet Menus” in the “Customizing Grapevine” chapter.)



Autosave. Check this box and set a time interval if you’d like Grapevine to make intermittent backup saves as you
work, in a file in the Grapevine folder called Autosave.gv3.

Action Settings
This tab controls the default settings Grapevine uses for working with character actions. (See the “Chronicle: Actions, Plots
and Rumors” chapter for more detail on character actions.)


Total Personal Action Value. Some games may assign a number to how much a character can accomplish by way of
her personal attention during downtime. Set that number here.



Always Add Common Actions. Ordinarily, creating an action will generate a single personal downtime action for a
character. But some games are more detailed, dividing a character’s downtime into personal actions, Influence
actions, and actions dealing with Backgrounds such as Contacts. Check this box to automatically generate such detail
when creating a new downtime action.



Copy Unused Values from Previous Action. Selecting this option will look to a character’s previous action every time
you create a new one, and copy any “Unused” value from specific actions that it finds there. This is useful, for
example, if your game runs twice a month but your Influence actions only reset once a month.



Action Values. Detailed Influence actions usually associate a value with each level of Influence a character has,
representing just how much she can do with it during downtime. (The MET book Dark Epics describes a detailed
system for this idea.) This list sets the value associated with each level of an Influence. Click a level of Influence and
adjust its associated value on the right.



Backgrounds with Action Values. Some Backgrounds, like Contacts, can also be used in a manner like Influence. This
list specifies what Backgrounds those are. Click Add to specify a new Background or Delete to remove one.
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Rumor Settings
This tab deals with how the standard set of rumors is generated. (See the “Chronicle: Actions, Plots and Rumors” chapter for
more about generating standard rumors.) Check the boxes to automatically generate the following types of rumors:


Public Knowledge Rumors. A single rumor that all characters will receive.



Personal Rumors. These rumors go to individual characters alone.



Racial Rumors. These rumors go to all characters in the game of the same race: Vampire, Werewolf, Mortal, Mage,
etc.



Group Rumors. This provides a rumor to be received by each different clan, tribe, kith, etc. (Groups are shown in a
column of the Characters window.)



Subgroup Rumors. This provides a rumor to be received by each different sect, auspice, seeming, etc. (Subgroups are
shown in a column of the Characters window.)



Influence Rumors. This generates rumors for each type of Influence in your game. You have the option of filling out
separate rumors for each level of the Influence up to level ten. Rumors will not be generated for Influences nobody
has.



All Additional Rumors from the Previous Session. After generating all the above rumors, look at the rumors for the
previous game date. Any rumors that appear there and have not been generated will also be brought forward. Using
this option, custom rumors like those tailored toward characters with Nightmares or characters in a certain noble
house can persist from game session to game session.



Copy All Rumor Text from Previous Session. If the text of your rumors is persistent as well, this selection will also
copy the text from the previous session. This will only take effect if the “all additional rumors” option is checked.

Working with Player Information
The Players menu in the main Grapevine window offers a number of utilities for managing information about the people who
play your game.

Player List Window
Choose “Players...” to summon a window listing all the players in your game. The list of players is at the left. Clicking a name
displays some basic information about the player at the right. Three buttons help edit your player list:


Show Player. Displays the Player Information window where you can record the player’s contact information.



Add Player. After prompting you for a name, a new player is added to the list and selected.



Delete Player. Deletes the selected player from the game.

To arrange the listing of players to your liking, click the column header of the item you want to sort by – such as sorting by ID
or by Position. You can control whether the sort is ascending or descending by using the up/down buttons to the lower right
-6-

of the list. If you want to limit the listing – say, only listing active players or only listing the staff of the game – you can select
your search from the dropdown box beneath the list, and use the option buttons to its left to describe whether you want to
see all characters who fit the search or who don’t fit it.

Player Information Window
Select a name and click “Show Player” to display a Player Information window that functions similarly to the Character Sheet
Window (see “Character Sheet Basics” in the “Working with Characters” chapter). It is divided into three different tabs. The
fields you’ll find here are the following:


Name. The player’s name can be edited at the top of the window.



Identity Tab





Position. The staff position of the player, if any.



Status. Whether the player is active or inactive.



Player ID. The player’s membership or ID number.



Phone. The player’s primary phone number.



E-Mail. The player’s primary e-mail address.



Address. The player’s mailing address.



Notes. Any extra information.

Characters Tab




A list of all the characters this player plays appears here. Select a name and choose “Show Character Sheet” to
open the corresponding character sheet window.

Player Points (PP) Tab


This area displays the current unspent and earned totals of player points associated with the player, as well as a
history of their earnings and expenditures. The tools on this tab function identically to those of the Experience
Tab in a character sheet window (See “Experience Histories” in the “Working with Characters” chapter).



Last Modified. The date upon which the player information was last edited.

Maintaining Player Points
Player points are a number of generic “points” associated with each player in the game. While many Storytellers will have no
use for player points, they can fulfill several possible roles. Some games may use this field to record prestige or member class;
others may use it to record “service points” rewarded for helping set up and clean up, playing NPCs, and bringing snacks.
Choosing “Player Points...” from the “Players” menu will load a maintenance window. This window may be used to make
adjustments to many players’ points all at once, or to keep detailed records of where and when players earned and spent
their points. Using this maintenance window is functionally identical to maintaining characters’ experience points. See
“Maintaining Experience Points,” in the “Working with Characters” chapter, to understand the use of the Player Point
Maintenance window.
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Sending E-Mail to Players
This feature enables you to send an e-mail message to a selection of the players in your game. See the section “Sending
E-Mail” in the chapter “Printing, Saving and E-Mailing Sheets and Reports” for a description of the windows you work with
here. The main difference in using this feature is that the only information you send are the message and attachments: no
character sheets or reports are sent.
If you have not set up your SMTP server before using this feature, you will be prompted to do so as described in the “Sending
E-Mail” section.

Working with Characters
Maintaining character information is one of the most detail-oriented tasks that face a Storyteller, but Grapevine eases the task
by organizing all the data within a few mouse-clicks’ reach.

Character List Window
This window, reached via “Character Sheets...” from the Characters menu, is your starting point for entering and maintaining
character information.
The list of characters begins each line with an icon representing the character’s race, followed by its name, its main racial
group (clan, tribe, tradition, kith, etc.), its subgroup (sect, auspice, seeming, etc.), its NPC status (an X appears if it’s an NPC),
and its play status (active, inactive, dead, etc…). Clicking on any entry displays at the right its racial icon, name, player,
experience points (unspent and earned), and the last date upon which it was modified.
This list can be refined and sorted (see “Sorting the List of Characters,” below).

Showing a Character Sheet
To view any character sheet, select the character’s name and click the “Show Character” button. Double-clicking the also does
the trick.

Adding a New Character
To add a new character to your game, click the “Add New Character” button. A small window appears prompting you for the
name of the character. Below the name appear a variety of buttons corresponding to the supernatural races of the World of
Darkness. Click the button appropriate to the character after entering his or her name. The choices include:


Vampire. The Kindred are described in MET books such as Laws of the Night, Laws of Elysium, Faith and Fire, The
Camarilla Guide, The Sabbat Guide, and The Vampire Storytellers Guide.



Werewolf. The Garou are described in Laws of the Wild and Laws of the Wyld West.



Mage. Willworkers are described in Laws of Ascension and the Laws of Ascension Companion.



Wraith. The Restless are described in Oblivion. This category encompasses Wraiths, Spectres and Risen.



Changeling. The Fae are described in The Shining Host and The Shining Host Players Guide.



Hunter. The Imbued are described in Laws of the Reckoning.
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Mortal. Ordinary and extraordinary humans are the focus of Laws of the Hunt and Laws of the Hunt Players Guide.
This character type is also a good choice for Ghouls from Libre des Ghoules, Kinfolk, Kinain, and other mortal allies to
supernatural races.



Fera. The Fera are described in Laws of the Wyld West, Changing Breeds: Book 1, Changing Breeds: Book 2, and
Changing Breeds: Book 3.



Kuei-Jin. The Cathayans are described in Laws of the East.



Mummy. The Eternal appear in Laws of the Resurrection. Older versions appear in the Laws of the Hunt Players
Guide.



Demon. The Fallen are not currently described in any MET book – but their translation into the system is all but
inevitable. Storytellers can adapt them for their own use from the tabletop book Demon: the Fallen.



Various. This special character category is a catch-all for anything that doesn’t fit in with the above. Animal
companions, spirits, chimera, whatever – many Storytellers find it especially useful when fleshing out the game’s cast
of NPCs.

Below the buttons appears a checkbox that, if selected, will generate random Traits for the new character. This is particularly
helpful for creating NPCs. You can specify how many starting Physical, Social, Mental, Ability and Background Traits are given,
how many points of Negative Traits are allowed and how many Free Traits are available. These Traits may not really make
sense together: Grapevine doesn’t know that a Repugnant character isn’t likely to be Gorgeous, for example. You’ll still have
to edit away such inconsistencies.
After you click one of the above buttons, the character’s name will appear in the list. Click “Show Character” to bring up the
empty character sheet.

Deleting a Character
To delete a character, select its name and click the “Delete Character” button. You’ll be prompted to confirm that you really
want to delete the character. Once the character is gone, there is no getting that information back.

Copying a Character to a new Race
Select a character and click this button when another mortal is Embraced, or when that ill-treated mage dies and becomes a
wraith. This creates a basic copy of the character as another character type so that you don’t have to re-enter all the data.
Keep in mind, however, that some data will be lost: Grapevine just has no way to transform a werewolf elder into an
ancestor-spirit without losing detail.
Grapevine will prompt you for a new name; the old character won’t be deleted. When you have edited the new character to
your satisfaction, you can delete the old character and give the new one its original name.

Sorting the List of Characters
To sort the displayed list of characters, click on the column header of the characteristic by which you want to sort. Click
“Group” to sort alphabetically by group, “NPC” to segregate PCs from NPCs, and so on. Clicking the “Race, Name” column
once will sort the characters by name: if they are already sorted by name, clicking it a second time will sort them by race.
To change whether the characters are listing in ascending or descending alphabetical order, use the up and down buttons to
the lower-right of the list.
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By default, all characters are listed in the Characters window. The dropdown list beneath the list of characters lets you choose
subsets to display: instead of “All Characters,” for example, you can choose to show only “Active Characters” or maybe only
“Vampires.” The subsets you can choose from may be edited in the Character Search window. (See “Searching for Characters”
in this chapter.)
The option buttons to the left of the dropdown list control whether the window displays all characters that match or don’t
match the chosen search.

Character Sheet Basics
Grapevine has many different character sheet windows, each of which can hold multiple pages of information. Rather than go
over each field of each window, this is an overview of the common features you’ll find.











Character Name. This appears at the top of every character sheet window. Click the “Name” button beside it to
rename the character.
Category Tabs. Below the character name are a number of tabs, under which items on the character sheet are
grouped onto pages; click on a tab to switch to its page.
Menu List. When you click on any field in Grapevine, this list on the left will fill with data you may choose to add to
the character. Clicking on any item in the menu displays it in full beneath the list. Double-clicking on any item serves
the same purpose as the “Add” button.
Add. Click this button to add the selected item from the menu to the character sheet. If the selected item is a Trait of
any type, the number of the corresponding Trait on the character sheet will increase by one. If the selected item is
actually a submenu, the menu window will fill with new data and you’ll have to choose another item. If the selected
item is “(top)”, you will be taken to the top level of the menu.
Remove. This button removes the Trait you have currently selected on the character sheet, or clears the field you last
clicked.
Add Note to Entry. This button adds a note in parentheses to the item you selected on the character sheet. You can
use this to annotate a character’s Performance Ability to Performance (Singing), for example, or add a line of detail to
a Merit or Flaw. If you want to erase a note from the selected data, click Cancel.
Custom Entry. This button displays a window that allows you to add data of your own creation. In the first field you
type the data you want to add: perhaps a custom title like Eldest Homid or a custom Negative Social Trait like
Harmless. If you’re adding a Trait, you can adjust the number you want to add in the next field. The last field allows
you to provide a note. A box at right displays the data as it will appear when you add it. Click “OK” when you’re done.

The arrangement of information on the character sheets is different for every supernatural race, but here are the basic tools
you’ll work with:


Fields. A field is a single item of data with no associated number; Clan, Nature, Demeanor, and Player are examples of
fields. Click on a field and the menu will fill with possible values.



Custom Fields. Custom fields list nothing in the menu window; their values are user-defined. Type your own
information into any custom field, such as Name, Character ID, or a mortal’s Title.



Number Fields. Number fields have a single number you can change with arrows at its right. Generation and Spirit
Notoriety are examples of number fields.



Temper Fields. Temper fields are like number fields, only they display a number of dots as well. Tempers, which
include such values as Willpower, Blood, Rage, and Glamour, have both permanent and temporary ratings. By default
the arrows at right edit the permanent rating, but by clicking the field directly you toggle on and off a display of the
temporary rating. While the temporary value is visible, the arrows edit the temporary rating. If either the permanent
- 10 -

or temporary rating becomes greater than 10, the display of dots becomes abbreviated: each large dot that appears
equals five small dots.


Check Box. This simply signifies what a character is or is not – like an NPC.



Trait List. This is what you’ll use for Physical Traits, Abilities, Backgrounds, etc. Items in a Trait List are displayed
according to the format Name xN (Note), where N is the number of Traits. When you click a Trait List, the menu
window fills with potential values and two small buttons marked “+” and “–” appear above the list. Selecting a Trait
and clicking those buttons increases or decreases the number of the Trait.



Trait Maximums. Physical, Social and Mental Traits may have Trait Maximums associated with them: these
maximums are displayed beneath the corresponding lists, and are editable with small buttons marked “+” and “–”
that appear beside them. Changing one changes the others as well, unless you have selected the option “Edit
Physical, Social and Mental Trait Maximums separately” in your Game Settings.



Variable-Cost List. This is the kind of list used for Merits and Flaws. Items are displayed according to the format Name
(N” if there is no note or Name (N, Note) if there is a note, where N is the cost of the item. Clicking a variable-cost list
populates the menu window and displays the “+” and “–” buttons. Selecting an item and clicking those buttons
increases or decreases the cost.



Simple List. This list is used for Disciplines, Gifts, Edges and the like. No cost or number is associated with the items.
Clicking this list populates the menu window but does not display the “+” and “–” buttons.



Long Text Field. A long text field is where you can type multiple lines of information. Equipment and Notes fields are
of this type.

The following fields are some you’ll find on every character sheet:


Name. A field for the character’s name.



Player. A field for the player’s name. The menu for this field comes from the player information you’ve entered.



Character ID. A custom field for any kind of character ID you’d like to use.



Status. By default, this is set to Active; it reflects the current status of the character in the game. Keeping this field
accurate will help Grapevine automate many tasks for you. Other statuses include Absent (if the character will be
missing for just a session or two), Inactive (if the character is out of the game, temporarily or indefinitely), and Dead
(if the character was killed).



Experience Unspent/Earned. Clicking this field takes you directly to the Experience tab of the character, where the
character’s experience history may be edited. See “Experience Histories,” below.



NPC. A check box signifying whether this character is or is not an NPC.



Notes. Every game has different needs. If the character sheet has no other place to record some important
information, record it here.

Another tool available on character sheets is the Trait List popup menu. Right-click on any Trait List to summon this miscellany
of functions that advanced users may find useful. The choices that can appear on the menu include:


Add random entries. Select this function and specify a number to add a random set of menu selections to the list.
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Randomize these entries. Upon selecting this function, you will be prompted for the number of Traits you would like
the list to hold. No new Traits will be added to the list, but the number associated with each entry will be randomized
so that the total adds up to the target you specify. If your number is less than the Traits in the list, some will be
randomly removed.



Change display. Traits in a list can be displayed in a number of ways – choose this function to experiment with a new
display style for the list.



Turn alphabetization on/off. This function toggles whether the list is kept in alphabetical order, or in an order you
specify. New entries are added to non-alphabetized lists in the order suggested by the Grapevine Menus.



Make entries divisible/indivisible. Most Traits are divisible: Stealth x5, for example, can be divided into Stealth x2
and Stealth x3 and the meaning doesn’t change. But some Traits are not divisible: Enemy (5) has a different meaning
from the pair of Enemy (2) and Enemy (3). This function toggles the divisibility of the entries in a list.



Remove all. Completely empty the Trait List.

Experience Histories
Every character sheet also has a tab labeled XP. Clicking this tab displays the character’s current and unspent experience totals
above a history of all its earnings and expenditures.
Note: The Experience tab is functionally identical to the Player Points tab in a Player Information window, only with a few
more character-specific fields and menu options.
The following fields that appear on the tab:


Experience Unspent. The experience the player has yet to spend on the character. If the “Enforce Experience
Histories” option in your Game Settings is checked, the field is locked and can only be changed by editing the history.
If the history is not being enforced, the field is freely editable.



Experience Earned. The total experience the character has earned. It is locked or editable in the same manner of the
Experience Unspent field.



Point Counting Aid. This button opens a window that helps you total up the points on a character: see “Counting
Points on a Character,” below.



Assigned Narrator. The Narrator assigned to this character, crucial for large games. The menu for this field is
assembled from the player information you’ve supplied; namely, everyone who doesn’t hold the position of Player.



Starting Date. The date of the first game in which the character appeared. By default this will be set to the date on
which you created this character sheet.



Last Modified. The last date upon which the character was edited.

Below these fields is a detailed history of the character’s experience earnings and expenditures. Clicking the history loads
special entries into the menu window and changes the function of some buttons beneath it:



Add New Entry. This, the first menu option, creates a new history entry for your records. A window appears in which
you may specify the date of the entry, the type of change (earn, spend, lose, un-spend, etc.), the amount of change
and the reason for the change.
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Recent Purchases. This second menu option creates a new history entry in which Grapevine takes a wild guess at the
total experience cost of the recent changes you’ve made to the character sheet. Review the cost and the reason
closely: Grapevine assumes that all Traits cost experience and that all decreases in Traits are refunded. You may have
to correct Grapevine’s guess before committing the entry to the history.



Other Standard Experience Awards. The rest of the entries in the menu window are the standard experience awards
for your game. These may be edited in the Experience Points window (see “Managing Experience Points,” below).



Add and Remove. These buttons serve familiar functions, adding and removing the history entries you select. Adding
an entry always loads a dialog box to confirm the details, while removing an entry always prompts you for
confirmation.



Edit Entry. Select a history entry and click this button to change its details.



Clear History. Click this button to erase the entire experience history. You will be prompted for confirmation.

Counting Points on a Character
On the Experience tab of each character sheet is a small button labeled “Point Counting Aid.” Click it to open a window
designed to help with this task.
The point counting window opens with a list on the left of all the numbers on the sheet. It guesses the number of points
spent on Physical Traits, Abilities, Disciplines and so on, subtracts the points earned from Negative Traits and Flaws, and
presents the estimated balance on the lower left. This number is probably way off.
The estimate is inaccurate because Grapevine can’t tell when Traits are gained through Advantages or Disadvantages, or when
Disciplines cost extra for out-of-clan, or for levels of Lore that are granted for free in play. The next step, therefore, is to
proceed down the list, correcting the numbers Grapevine has estimated. Click on an entry at left to see its Traits listed on the
right. Below that listing is the number of points spent or earned: adjust the number until it is correct.
Do this with each item on the character sheet, and if your bookkeeping has been good, the total you arrive at should equal the
total number of XP spent on the character. The scales balance, confirming your work.
Your balanced estimates cannot be saved – you’ll have to do the work again if you have reason to count the points on the
character again.

Maintaining Experience Points
The “Experience Points...” option under the Characters menu displays a window upon which to award and expend character
experience points, en masse or individually. Three tabs at the top of the window offer Group Maintenance, Attendance View
and Standard Award tools for working with this data.
Note: The Experience Points window and the Player Points window are functionally identical.

Group Maintenance
Visiting the Group tab makes it possible to updates many characters’ experience at once. On the left side of the window is a
list of all the characters in your game. Clicking the name of an unselected character will select it, and vice versa. Select the
names of all the characters whose experience you want to adjust.
Shortcuts for character selection appear below the list:
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Select from Search / Select not from Search. These option buttons, and the dropdown list of searches to their right,
allow you to select all characters in the game that match or do not match a saved search (see “Searching for
Characters” in this chapter). Simply select a combination of search and condition, and the corresponding characters
will be selected.



Select All. Selects all characters in the game.



Select None. Deselects all characters in the game.

After you’ve selected characters, the right part of the window is where you will specify the type of change to make. Use the
following tools:


Standard Experience Award. Choose one of your game’s standard experience awards from the list, and the rest of the
information is filled out automatically. Standard experience awards can be edited on the Standard Awards tab.



Custom Change to Experience. Specify the type and amount of change to the selected characters’ experience points
here. The amount may include decimal portion. The types of change you can make are these:



Earn. Add the amount to both the unspent and earned totals.



Spend. Subtract the amount from the unspent total.



Lose. Deduct the amount from both the unspent and earned totals.



Unspend. Add the amount to the unspent total without affecting the earned total.



Set Unspent To. Set the unspent total to the given amount.



Set Earned To. Set the earned total to the given amount.



Comment. Make no change to the experience totals, but add a date-stamped comment to the history.



Date. The date of the new experience history entry.



Reason. A short description of the reason for the change.



Record this Change in the Histories. If you have not selected the Enforce Experience Histories option in your Game
Settings, you may deselect this option to simply apply the experience change without making an entry in the
experience histories.

All said and done, click the “Change Experience” button in the lower right. Grapevine will ask if you are certain you want to
make the given changes to the selected characters’ experience. Click “Yes” to apply the changes.

Attendance View
The Attendance view tab is a second style of group experience point management. With its list of characters, you control who
earns standard experience awards on a given date. Despite the name of the tab, you can do this for any standard experience
award, not just for attendance.
On the left is a listing of the characters in the game. The first column lists a checkbox beside each character name. If the
character has earned the experience award shown on the right, for the date shown on the right, the checkbox is marked. The
second column shows the amount of the award, and the third column shows the total amount of experience earned in the
month.
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Checking the box beside a name will add the selected experience award to the character’s experience history, on the selected
date. Un-checking a box will delete the corresponding entry.
The first dropdown list on the right selects the date to examine. You may enter a date in the box by hand if you want to
examine the awards given on a non-game date.
The second dropdown list on the right selects the type of standard award to manage. Edit this list and its awards on the
Standard Awards tab.
The two option buttons and the third dropdown box beneath them control which characters are displayed in the list. Clicking
any column header will sort the list by that column, and clicking twice will reverse the sorting.
In the lower right is a “Show Character History” button. Clicking it will load the character sheet of the currently selected
character, and take you directly to its Experience tab.

Standard Awards
The Standard Awards tab is where you create and edit the experience point awards you most commonly use in your game.
These awards can be assigned to recipients from the other tabs in the Experience Points window, or added from the menu in
any character sheet’s individual experience history (on the Experience tab of the character sheet window).
A list of the names and amounts of the awards appears on the left of the Standard Awards tab. Beneath it is an “Add” button,
which creates an award after prompting you for its name, and a “Delete” button, which deletes the award selected from the
list.
When you select an award from the list, its information is displayed on the right: its name, its type of amount of change, and a
default description of the reason for that change. Edit this information to alter the selected experience award.

Permanent and Temporary Ratings
The “Perm/Temp Ratings...” command in the Characters menu opens a window where you can manage the permanent and
temporary ratings for values that measure them: Willpower, Honor/Glory/Wisdom, Glamour and Banality are common
examples. These values are called Temper Traits, or Tempers for short.
The main list in this window displays character names, followed by the permanent and temporary ratings of the Temper being
edited, a display of dots, and the difference between the permanent and temporary ratings. You may sort the list by any of
these criteria by clicking the corresponding column header. You may also filter characters from the list by using the Search box
and options below the list.
First select the Temper you are going to edit from the dropdown list in the upper right. Only characters that have this Temper
appear in the main list; if you choose to manage Blood, for example, you won’t see any werewolves listed at left. Various-type
characters will never appear in the list: Grapevine manages their Tempers without permanent and temporary ratings.
By default, all the characters listed are checkmarked. Click the mark or double-click the character name to toggle the
checkmark off any character you do not want to edit. Grapevine applies the changes you make only to checkmarked
characters.
The second dropdown list on the left describes the change you want to make to the temporary rating of the characters’
Tempers. You can increase or decrease the rating, set the rating to a given value, or “fill” the Tempers so that their temporary
Traits equal their permanent Traits.
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Enter the amount of the change you want to make into the next text box. Two options below this box provide extra control.
Selecting “Randomly” changes the number from a single value to an editable range of values, one of which will be randomly
chosen to adjust each Temper. Selecting “Go no higher than the permanent rating” ensures that no temporary value will be
increased or set higher than its permanent value. In no case will any temporary rating be decreased below zero.
Once you have finished defining the change you want to make, one click of the button labeled “Apply the Change” will adjust
all the checkmarked characters listed at left.
Whenever you select a character from the list, Grapevine displays its permanent and temporary Temper ratings in the lower
right of the window. Tweak these values yourself to manage the character individually. Clicking the “Show Character” button
displays the corresponding character sheet.

Vampire Boons and Status
The “Vampire Boons & Status” command from the Characters menu displays a window specially tailored for the needs of a
typical game of Vampire.
Many controls in this window are similar to those of the character sheets. See the section “Character Sheet Basics,” above, to
learn about the Menu List, the buttons beneath it, and the fields they modify.

Boons
Click the “Boons” tab to display a list of all the outstanding boons in your game. Click a column header to sort the boons by
that value.
Click the “Add New Boon” button to add a new boon to the game, or select a boon from the list and click “Delete Boon” to
remove it.
Once you select a boon from the list, you may edit its information in fields below the list:


Type. The type of the boon, such as Trivial, Minor, Major, Blood or Life. Click the field to display choices in the menu
list.



Due From. The character who owes the boon. Click to edit.



Owed To. The character to whom the boon is owed. Click to edit.



Date. The date of the boon. Enter a date yourself.



Description. A description of the boon you provide.

Status
Click the “Status” tab to display a list of the vampires in your game, including the number of Status Traits they hold, their
titles, their clans and their sects. This list may be modified using the Search box and options above it. Click any column header
to sort the list by the corresponding value.
Selecting any vampire displays its name, title and Status Traits below the list. You may modify its title and Status Traits just as
you would on its character sheet. Clicking the “Show Character” button will display that sheet.
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Searching for Characters
The “Search for Characters...” command in the Characters menu displays a window you can use to find characters meeting
complex search criteria. You could search for all characters with a Generation lower than ten, Media Influence of at least
three, or the Nightmares Flaw, for example.
At the top of the window is a dropdown list of saved searches. Select one to perform that search automatically. These can also
be used from the Characters or the Statistics windows to examine the lists of characters that they match.

Creating a Search
First, use the “Any” or “All” option buttons to select whether you want to find characters that match any of the criteria you
specify, or all the criteria to specify. Matching all defines a narrower search than matching any.
Next, use the “Add Term” button to add a new search term. It should appear with a number 1 in front of it. If you previously
selected a saved search from the dropdown list, this term may already be there. If there are more terms following it, click the
“Remove Term” button until you’ve reduced the terms to just one.
Now use the first drop-down list of the term to select some character aspect, such as Generation or Influence. Use the next
drop-down list to choose the type of match you want to make. Check the NOT checkbox beneath it if you want to match
characters that don’t fit the criterion you specify.
If the character aspect you chose is a single-item text field like Clan or Nature, the types of match include:


Contains. Matches if the aspect contains your search text.



Equals. Matches if the aspect is exactly equal to your search text.

If the aspect you chose is a single-item numerical field like Generation or Rage, the types of match include the following,
which all correspond to basic mathematical comparisons:


Is Less Than. (x < y)



Is No More Than. (x ≤ y)



Equals. (x = y)



Is At Least. (x ≥ y)



Is Greater Than. (x > y)

If the aspect you chose is any kind of list, such as a list of Physical Traits or Merits, the types of match are:


Total Less Than. Matches if the total is less than the given number.



Total No More Than. Matches if the total is less than or equal to the given number.



Total. Matches if the total number of items in the list matches the number you specify.



Total At Least. Matches if the total is equal to or greater than the given number.



Total More Than. Matches if the total is greater than the given number.



Contain. Matches if one Trait in the list partially matches the text you specify.
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Contain the Note. Matches if the note of one Trait in the list partially matches the text you specify.



Contain Less Than. Matches if the list contains less than the given number of the given Trait (but contains at least
one).



Contain No More Than. Matches if the list contains no more than the given number of the given Trait (but contains at
least one).



Contain Exactly. Matches if the list contains exactly the given number of the given Trait.



Contain At Least. Matches if the list contains at least the given number of the given Trait.



Contain More Than. Matches if the list contains more than the given number of the given Trait

The last field is where you type the text or the number you’re searching with. Sometimes there will be two fields, the first for
text and the second for a number.
Once you’ve entered all the search criteria, you can click the “Add Term” button to add more criteria. If you want to remove
criteria, click the “Remove Term” button.
Last, use the “Sort by” dropdown list, and the associated “Ascend” or “Descend” option, to choose how your list will be
sorted. Usually you will sort by name or by the values that match your search terms; but sometimes you may want to see list
of all characters sorted by their total Physical Traits, for example.
When you’re ready to search, click “Perform Search.” If any characters match your criteria, the list at the top of the screen fills
with their names. Select any name and click the “Show Character” button to load the character sheet.
If no characters matched your criteria, “0 Results” appears beneath the empty list.
If a character does not even qualify for a search, the search will not match it. A search for “Glamour is Less Than 4,” for
example, will never match a vampire. Vampires don’t have the Glamour value and don’t even qualify.

Saving Searches
Click “Save Search” if you’d like to save a search and make it available to the dropdown lists in such places as the Characters
window and Statistics window. Grapevine will prompt you for a name under which to save the search. If you enter one that is
already in use, you’ll be prompted to confirm that you want to overwrite the existing search.

Deleting Searches
After selecting one of the saved searches from the dropdown list, click “Delete Search” to remove it.

Most Recent Search
In any other area of Grapevine that allows you to select or view characters by a saved search, a search called “Most Recent
Search” will appear after you have used the Search for Characters window. Selecting it will return the same results as the last
search you performed in this window.

Statistics
This window offers statistics about the characters in your game – levels of Influence, populations of clans, etc. Choose one of
three types of graph type:
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Distribution. This type of statistic plots the different values for a chosen characteristic against the number of
characters that have that value. In other words, use populations to tell you how many characters of each clan are in
your game, what the distribution of total Social Traits is, or how many characters have degrees of Pure Breed.



Maxima. This type of statistic is appropriate for use with Traits or numeric data – it reports your game’s highest levels
in the area selected. Use maximums to monitor the highest levels of Influence or Backgrounds presently in your
game. If three people in your game have Street x1, two people have Street x2, and one person has Street x3, this
statistic will report 3 as the maximum for Street.



Sums. This type of statistic reports the sum total of all such Traits in the game. It provides another perspective with
which to examine at Influences and similar characteristics. If three people in your game have Street x1, two people
have Street x2, and one person has Street x3, this statistic will report 10 as the sum for Street.

Use the “Whom to Graph” dropdown list to choose the set of characters you want to examine, and use the “Data to Graph”
dropdown list to choose the particular character data you want to graph.
If you are graphing a Distribution and you select a list of Traits such as Influences or Physical Traits or Merits, several
additional options appear. The top option button graphs the distribution of total Traits in the list, while the bottom button and
the text box beside it allow you to graph the distribution of one specific Trait.
If you are graphing a Distribution, a checkbox also appears that allows you to exclude all entries of zero Traits or empty fields
(“none”) from the statistics.
The graph below displays the statistics in the manner of a bar chart. Click any bar to open a list of all the characters that were
found to contribute to that statistic. In graphs of distinct distributions, maxima and sums, each character name in the list will
be preceded by the number of matching Traits it has.

Defining the Game World
The World menu offers tools with which you can describe key locations and items in your game world.

Items
Choose “Items...” to describe the equipment that fills the characters’ pockets (and jackets and trench coats). You will see a
window with a list on the left naming all the items in your game. Click the name of any item to select it and display how many
are in play. Three buttons are beside the item list:


Show Item. Displays the Item Card window where you can describe the item.



Add Item. After prompting you for a name, Grapevine adds a new item to the list and selects it.



Delete Item. Deletes the selected item from the game.

Selecting and item and clicking “Show Item” will display a window similar to a Character Sheet Window (see “Character Sheet
Basics” in the “Working with Characters” chapter). You’ll find the following fields:


Name. The name of the item.



Basics Tab
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Type. Its type, such as Equipment or Treasure. The arrows beside this field adjust the point rating of the item.



Subtype: What subtype of the item is, such as Ranged Weapon or Armor.



Bonus. The type of bonus it grants. The arrows beside the field adjust the number of Bonus Traits.



Level: This can describe the level of equipment or just the number of Background points used to purchase it.



Damage/Armor. For weapons, the health levels in damage it will do and what type of damage it is (Bashing,
Lethal, or Aggravated). For armor, how many health levels it has.



Concealability. How easily the item can be hidden on one’s person.



Tempers. Some items have ratings in Gnosis, Quintessence, Glamour, etc.



Negative Traits. A list of the item’s Negative Traits.



Abilities. A list of the item’s special abilities.

Details Tab


Appearance. What the item looks like.



Powers. Describe here the magical or non-standard powers of the item.



Notes. Any extra information.



Availability: What levels of Influence it takes to get the equipment.

In Play Tab


Units in Play. This cross-references the characters that list this item as equipment – and how many times each.
Select a character name and click the “Show Character” button to load its character sheet.



Last Modified. The date upon which this item was last edited.

Locations
Choose “Locations...” to describe the areas where action takes place in your stories. The resulting window has a list on the left
of all the locations in your game. You can sort each column by clicking on the column header and it will sort by that column.
Click the name of any location to select it. Beside the list are three buttons:


Show Location. Displays the Location Card window where you can describe the location.



Add Location. After prompting you for a name, a new location is added to the list and selected.



Delete Location. Deletes the selected location from the game.

When you select a location and click “Show Location,” a Location Card window appears that functions similarly to the
Character Sheet window (see “Character Sheet Basics” in the “Working with Characters” chapter). It is divided into three
different tabs. The fields you’ll find here are the following:


Name. The name of the place.



Basics Tab


Type. The type of location, such as Elysium or Caern.
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Level. This can describe the level of a caern, Node, freehold, or just the number of Background points used to
purchase it.



Owner. The location’s owner.



Where. The physical location of this place in your setting – as general as “east of the mountains” or as specific as
a street address.



Appearance. What the location looks like.

Security Tab


Access. The type of access typical of this site, such as Public or Private.



Security Traits. The Trait difficulty an intruder must defeat to bypass the security system.



Security Retests. The number of retests the security system can use against the intruder.



Security. A description of the rest of the security at the place.

Supernatural Tab


Totem. The totem spirit (for caerns).



Affinity. The location’s spiritual or magical affinity.



Gauntlet/Shroud/Banality. The thickness of the local Gauntlet or Shroud, or the Banality level of the site, as
appropriate.



Moon Bridges/Trods. Mystic links maintained with other sites. Adding or removing a location to this list will also
add or remove this location from the other site’s moon bridge/trod list.



Umbra/Shadowlands/Dreaming. A description of the Umbral, Shadowland, or Chimerical appearance of the
area.

Regulars, Notes Tab


Regulars. This cross-references all the characters that list this place as a frequented location. Select a character
name and click the “Show Character” button to load its character sheet.



Notes. Any extra information.



Last Modified. The date upon which this location was last edited.

Rotes1
Choose “Rotes...” to describe the rote that the characters know. A window with a list on the left appears, naming all the rotes
in your game. Click the name of any rote to select it and display when the rote was last modified. Three buttons are beside the
list:


Show Rote. Displays the Rote Card window where you can describe the rote.

1

White Wolf's copyright forbids me from redistributing the rules for each rote. "Rotes.gex" provides book and page
references instead. Fill out the rote cards in detail as you need them, or collaborate with other Storytellers to amass a
complete collection.
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Add Rote. After prompting you for a name, Grapevine adds a new rote to the list and selects it.



Delete Rote. Deletes the selected rote from the game.

Selecting a rote and clicking “Show Rote” will display a window similar to a Character Sheet window (see “Character Sheet
Basics” in the “Working with Characters” chapter). You’ll find the following fields:


Name. The name of the rote.



Rote





Level. The level of the highest sphere in the rote.



Duration. How long the rote lasts.



Description. A description of the rote and what it does.



Spheres. What spheres are necessary to cast the rote.



Grades of Success. What the various grades of success will do.

In Play


Rotes in Play. This cross-references the characters that know this rote. Select a character name and click the
“Show Character” button to load its character sheet.



Last Modified. The date upon which this rote was last edited.

Chronicle: Actions, Plots, and Rumors
For most games, the action doesn’t stop between sessions. The characters fill the intervening time with preparations,
scheming and training. The secretive forces behind the plot continue to grow and evolve. As a Storyteller, your job is to
coordinate all these complex factors to present a dynamic game world. Grapevine offers chronicle tools to help you achieve
this goal.

How to Do Downtime
To use the chronicle tools, you’ll build the events between game sessions using a three-part framework:


Actions. Actions are the characters’ activities between sessions. Many Storytellers gather this information through
written or e-mailed reports. Actions can affect and be affected by other actions and plots, and can generate rumors.
They also generate immediate results for the character.



Plots. Plots are the background goings-on of the game world. They can affect and be affected by other plots and
actions, and can also generate rumors. Plots are unconnected to any particular character and tend to persist for a
certain period of time.



Rumors. Rumors are the tidbits of information that characters learn through their usual routines, gathered from
sources such as Influences, supernatural informants, and the nightly news. In Grapevine, plots and actions generate
the rumors characters hear.
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The following sections describe how to go through this process for your game.

The Chronicle Sequence in Brief
The following sequence of steps is the recommended means to complete your downtime chronicle work as efficiently as
possible. More detailed explanations of working with Actions, Plots and Rumors follow.


Add the upcoming Game Session to the calendar. If you haven’t done so already, choose “Dates” from the Game
menu and click on the date of the upcoming game to make it available to the chronicle functions.



Create the standard Rumors – but don’t write them yet. You can do this quickly by selecting the date of the next
game and clicking the “Add Standard Rumors” button in the Rumors window.



Begin developing all the active Plots in the game. Make sure that all the plotlines in your game have at least been
created in Grapevine and given a brief outline. Then click “Develop Active Plots” from the Plots window. This will add
a plot development with the upcoming game date to every active plot. Visit these plot developments to describe
what’s going to happen at the next session. If any of these plot developments affect the rumors characters will hear,
now you can begin writing those rumors as well.



Add Actions as players send in their activities. Now you sit back and wait for the e-mails and phone calls to start
pouring in. As you learn what each character is doing in his downtime, create an action for him. Fill in what the
character is doing and what results he gets. If the character’s actions affect other actions, plots or rumors, revise what
you’ve written for those as well.



Finish developing the active Plots. After all the characters’ actions have been submitted, you have a clear picture of
all the factors affecting the game’s plot developments. If those factors change the plot’s effects on other actions or
rumors, make those revisions now.



Finish writing the Rumors. In this last step, you have a clear picture of all the factors contributing to the rumors for
the upcoming game. Finish writing them all to your satisfaction.

The Data Exchange features of Grapevine can help divide this work among the staff. Send copies of the game file to the
Narrators, while dividing responsibilities for different players, plots and rumors among them. Try not to let these
responsibilities overlap. The Narrators can send their work to the head Storyteller in the form of Grapevine Exchange files. The
Head Storyteller can then comb through their work to iron out the details of any complex interactions.

Example
Leading into the game of April 4, 2003, your game’s changelings intend to thwart the school board’s proposed dress code
policy. Here’s how you’d use Grapevine to help plan this session.


Create a game date for April. Click April 4, 2003.



Create the standard Rumors. From the rumors window, you select April 4 and click “Add Standard Rumors.” It occurs
to you that you’ll need a special rumor for the childlings in the plot, because they all go to school: You create a
custom-made “Schoolchildren” rumor for them. You don’t begin writing any of the rumors yet.



Develop the “Dress Code” plot. You already created and outlined “Dress Code” prior to the last game. You go to the
Plots window and click “Develop Active Plots.” A plot development for April 4 is added to the plot. You click “Show
Plot” and write under April 4 that the new dress code policy passes the school board and drives up the school’s
Banality by two points.
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A Sluagh player e-mails you a blackmail attempt. Sally Sluagh uses her Contacts to try to dig up some dirt on a school
board member. If she finds anything, she wants to deliver a blackmail letter. You create an action for Sally Sluagh on
April 4. You describe her actions and alter the Dress Code plot accordingly. You decide one of her contacts was
indiscreet, so you also leak a rumor about it.



A Sidhe player e-mails you a Media action. Gary ap Gwydion is the darling of the local news scene, and he’s covering
the story with some serious editorial bias. You create an April 4 action for him and use it to revise the Dress Code plot,
the Media rumors and the University rumors.



You complete the April 4 development for the Dress Code plot. Now that all the actions are in, you decide that the
school board postpones the decision on the new policy. That affects the University Influence rumor and the
Schoolchildren rumor. The board member being blackmailed sheepishly contacts the police, which you decide will
create a high-level Police Influence rumor. And another member of the school board has pull of her own in the local
media, so you take aim at Gary ap Gwydion and write in his action results that his bosses are giving him heat.



You finish writing Rumors. Now you review all the rumors and add finishing touches with an eye toward the actions
and plots that affect them.



You’ll see this example developed in more detail as you learn more about actions, plots and rumors.

Taking Action
Choose “Character Actions...” under the Chronicle menu to display the Actions window. From here you may add, delete and
show individual character actions.
The default display of this window lists the game dates at left, and on the right it lists the characters who have acted on the
selected date. When creating an action for a character, associate it with the date of the next game session. It’s at that session
she will see the results of her activities play out.
You can choose a different display by clicking the “View by Character” button in the lower left. This will list all characters with
actions on the left, and on the right it lists the dates the selected character has acted. Clicking the button again returns you to
the default display.
In either display, an X appears beside an action that has been marked Done – it has been filled out to completion.
Clicking “Add Action” will prompt you with a dialog. If you have a date selected on the left, it asks you to select a character; if
you have a character selected on the left (in View by Character mode), it asks you for a date. A new action is created for the
chosen date and character pair.
The “Delete Action” button deletes the action associated with the selected date and character. “Delete All Actions” will not
delete all actions in the game, but it will delete all those associated with the date or character you have selected in the
leftmost list – emptying the list on the right.
Select a date and name pair and click “Show Action” to edit the action for that date and character.

Editing a Character Action
The character action window appears with the name of the character and the date of the action at the top. Click one of these
to reassign the action to a different character or date.
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A “Show Character” button will direct you quickly to the associated character sheet. Use the “All Done” checkbox to records
when you’ve finished work on the action. The “Show Advanced” button gives you access to the detailed action functions,
described below.
At its most basic, a character action consists of four sections:


Action. Here, describe the action(s) this character takes during downtime before the selected game date. If you get
this information via e-mail from your players, you may choose to copy that text from your e-mail program and paste it
here directly.



Results. Use this field to inform the character about the results of his attempt. The Chronicle Report will include this
information for the player to read.



Affected By. This list bears the names of actions and plots that affect this action.



Affects. This list shows which actions, plots, and rumors that this action affects.

The Affects and Affected By lists are potentially two of the most powerful tools you can have to plan your game. Click the
“Add” button beneath either to summon a dialog listing all other actions, plot developments, and rumors for the game date.
Choosing from this list creates a cause-and-effect link between the two items. In this way you can manage dozens of factors
affecting the direction of the story. Double-clicking any link jumps you to the relevant action, plot or rumor. Following the
“Affected By” links is a good way to know what outside factors impact this action; following the “Affects” links you create is a
how you record the ripple effect a character action has on the game.
If you click the “Show Advanced” button at the top of the character action window (or if you have selected “Always Add
Common Actions” in your Action Settings), you gain access to the detailed character action functions.
The detailed action functions enable you to divide up character activities by topic. At the very least all characters have a
Personal action that represents what they do in person during downtime. But you may choose also to record in individual
actions how a character uses her Influence or Backgrounds such as Contacts. Every detailed action has its own distinct Action,
Results, Affected By and Affects information.


The Detailed Actions list. Each detailed action appears here, where you see its name, followed by its Level, Unused
and Total Action Values, and Growth. These four numbers can be edited in the fields to the right of the list.



Level. The level of an action. Usually this is the number of an Influence a player has.



Unused. Many games employ systems wherein a certain value is associated with the level of an action; portions of
this value may be spent to achieve the character’s goals. Unused is where the unused portion of that value is
recorded. If the option “Copy Unused Values from Previous Action” is selected, this value is copied from the
character’s last such recorded action.



of Total. The total action value associated with the level appears here. Its initial value (and thereby the initial value of
Unused) can be changed from Action Settings in the Game Settings.



Growth. Growth is a number used to judge how much progress a character has made toward a goal such as gaining a
new level of Influence. If this character has an action at an earlier date, Growth is set to its prior value when it is
created. This way a goal can be pursued over multiple downtime actions.



Add Action. Click this button and enter a name to add another detailed action to the list.



Delete Action. Click this button to delete a detailed action from the list. A Personal action cannot be deleted.
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Add Common Actions. Click this, and Grapevine will automatically add one action for each Influence the character
possesses and for each of certain Backgrounds like Contacts. Specifics can be set in the Action Settings tab of your
Game Settings. This will not overwrite detailed actions that have already been created.

Example
When last we left our intrepid figments, Sally the Sluagh was blackmailing the school board and Gary ap Gwydion was doing a
news story. Let’s examine those actions in depth.
You describe Sally’s actions by selecting “Show Advanced” and clicking “Add Common Actions.” This adds a Contacts action to
the Personal action that already exists. Selecting the Contacts action, you write that Sally is digging up dirt on the school
board. You decide she’s successful: in Results, you describe how Mrs. Pamela Grabowski has been embezzling funds from the
school sports program. But since Sally’s Contact was none too discreet, you decide Sally isn’t the only one who gets a hint of
this. You click Add under the Affects list and select the Underworld Influence Level 1 rumor to represent where word leaked.
Now that Sally Sluagh has the dirt, she uses it: in her Personal Results, you record how she delivers the blackmail letter to Mrs.
Grabowski’s house, and how Mrs. Grabowski seems to reverse her position on the dress code issue at the next board meeting.
That’s a direct effect on the Dress Code plot, so you add another link to the Affects list.
Meanwhile, Gary ap Gwydion is broadcasting a slanted story about the new policy on the nine o’clock news. You use the same
methods to create a Media action for Gary. In Results you describe the public outcry his news story arouses, and in the Affects
list you add the Media Influence Level 1 rumor and the Dress Code plot – both of which will suffer fallout from Gary’s
mudslinging.

Driving the Plot
The choice “Plots...” under the Chronicle menu displays the Plots window where you can track the progress of your game’s
plot threads.
The default display of this window lists the game dates at left, and on the right it lists plots you have created. The topmost
choice at the left, “List All Plots,” shows you all the plots you’ve created and whether they are Active, Finished or Pending (a
status derived from their start and end dates). If you select a game date from the left, the plots shown are only those for
which you’ve created plot developments for the selected date. A column labeled “Done” shows an X if you’ve filled in the plot
development.
You can choose a different display by clicking the “View by Title” button in the lower left. In this display, all the plots are listed
at the left. Selecting one displays all the plot development dates at the right, including the X for those that have been written.
Return to the original display by clicking the “View” button again.
Clicking “Add Plot” will prompt you for the title of the new plot. Unlike actions and rumors, which are associated strongly with
the game calendar, a plot is only loosely connected to any one game date – therefore you won’t be asked for one yet. Instead,
every plot is a collection of plot developments.
With a single click, you can use the “Develop Active Plots” button to add a new plot development to every plot that’s currently
active. If you’ve selected a game date on the left, “Develop Active Plots” will instead create a new development for every plot
that is active during the selected date.
“Delete Plot” will remove a plot and all its developments from the game.
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Clicking “Show Plot,” or double-clicking a selection, will load an individual plot window.

Editing a Plot
The plot editing window appears with the title of the plot across the top. Click the title to rename the plot. Below this appears
a series of buttons: First the “Outline” button where general information about the plot is kept, followed by a button for each
plot development you’ve created.
Selecting “Outline” allows you to specify the following:


Start Date and End Date. Use these to give your plot a beginning and an end. The status of the plot (Active, Finished
or Pending) is derived from whether the next game date falls between these dates. Choosing “(none)” leaves the plot
open-ended (or open-started).



Narrator. The staff member in charge of this plot.



Key Characters. The characters chiefly involved in this plot.



Outline/Notes. Use this space to describe the plot with a basic outline or important notes to remember when running
it.



Plot Developments. This list of dates is where you add and delete individual plot developments. Clicking the “Add”
button prompts you with a dialog box for the date of a plot development to add. “Delete” will remove a plot
development. The row of buttons at the top of the window will reflect all the changes you make here.

Clicking the date of a plot development will provide the following fields to fill out:


Plot Development: In this field, describe your plot developments for the upcoming game. This information is
confidential; it will appear in none of the player characters’ reports.



Affected By. This list bears the names of actions and plots that affect this plot.



Affects. This list shows which actions, plots, and rumors that this plot affects.

The Affects and Affected By lists are the same powerful tools you employ from the Action window to describe how this plot
affects and is affected by other factors in the game. See “Editing Character Actions” under “Taking Action” above for more
information about these lists.

Example
The deadline for player to send in their character actions has come and gone, so you decide to add the finishing touches to the
“Dress Code” plot you’re inflicting on the changelings.
When you initiated the April 4 plot development, you thought the dress code policy would pass the school board and raise the
Banality of the school. But Sally Sluagh and Gary ap Gwydion were resourceful in discouraging that outcome. Now in the
“Affected By” list, you see Sally’s Personal action and Gary’s Media Influence action listed. While you processed their actions,
you rewrote this plot so that the school board would postpone their decision after the public outcry from Gary’s news report.
This is going to cause a stir in several corners, so to the Affects list on the right you add the Media Influence Level 1 rumor, the
University Influence Level 1 Rumor, and the Schoolchildren rumor you created.
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But now you decide there will be other repercussions as well. Mrs. Grabowski, the unfortunate embezzler that Sally is
blackmailing, panics and goes to a friend in the police. The police arrest the contact of Sally’s that dug up the dirt – his nose
wasn’t clean either. You add a Police Influence Level 3 rumor (Mrs. Grabowski’s friend keeps things fairly quiet) to the Affects
list. You also add Sally’s Contacts action to the list. Double-clicking it, you revise her results to let her know that her contact
disappears complete after giving her the information.
You also decide that another school board member knows Gary’s boss, and that the Sidhe will draw some heat for his lack of
objective journalism. You add a Media Influence Level 3 rumor and Gary’s Media action to the Affects list. You revise Gary’s
Media Results to tell him about the fallout at the TV station.
You can tell that this plot is making waves. Only two characters’ actions affected it, but its own effects have mushroomed out
to affect Sally, Gary, the schoolchildren, and four different Influence rumors.

Rumormongering
The “Rumors...” selection in the Chronicle menu shows the Rumors window, in which you’ll supply your players with feedback
about the world for the upcoming game session.
The default display lists the dates of game sessions on the left, and on the right it lists rumors that have been written for the
selected session. An X appears in a column beside each rumor if it has been marked “Done” after all required rumors have
been written.
Clicking the “View by Title” button switches the display so that every kind of rumor you’ve ever written appears at the left,
while the dates for which these rumors have been written appear at the right. Again, completed rumors are marked with an X.
Clicking the button again returns you to the prior display.
The “Add New Rumor” button prompts you for a title (if a date is selected at the left) or a game date (if a title is selected at
the left). A new general rumor is created for the chosen date and title.
The “Delete Rumor” button deletes a rumor from the game. “Delete All Rumors” will delete all the rumors listed in the right
list – that is, depending on the view you’ve chosen, it will delete all rumors associated with either the date or the title that is
selected at left.
“Add Standard Rumors” looks at all the active characters in your game and at your Rumor Settings to generate a list of rumors
for the selected date. This list may include the following:


Public Knowledge. A single rumor that all characters will receive. This, as well as any custom rumors you create, is
denoted by the familiar ear icon.



Influence Rumors. Influence rumors have a skyline icon. Each type of Influence possessed by an active character in
your game will get its own Influence rumor. These specialized rumors consist of ten levels corresponding to the
number of Traits in an Influence a character may have.



Racial Rumors. These rumors go to all characters in the game of the same race: Vampire, Werewolf, Mortal, Mage,
etc. Their icon is a red ear.



Group Rumors. Group rumors are tailored toward clan, tribe, kith, and the like. Their icon is a blue ear.



Subgroup Rumors. These are intended for character subgroups: sect, auspice, seeming, etc. Their icon is a purple ear.



Personal Rumors. These rumors go to individual characters alone. Their icon is a yellow ear.
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Click “Show Rumor” or double-click a rumor from the list on the right to write individual rumors.

Writing General Rumors
A general rumor window appears with its name and date at the top. Click one to assign the rumor a new title or a new date.
An “All Done” checkbox allows you to mark when you’ve finished writing the rumor. You write the rumor with the aid of a
field and a list:


Rumor. The center of the window is where you provide the text of the rumor.



Affected By. Unlike actions and plot developments, rumors are entirely passive: they are the result of the tumult
behind the scenes, but they have no direct effects themselves. Hence, rumors have only an Affected By list. When you
write a rumor, refer to the actions and plots listed here to know what secrets to leak. See the “Editing Character
Actions” section of “Taking Action,” above, for more information on how to use the Affected By list.

Below the rumor text and to its right are the tools that help you specify who will receive the rumor you’ve written:


Send this Rumor to Characters that match... In the same way you can search for characters (see “Search for
Characters” in the Working With Characters chapter), you can specify who will receive this rumor. Choose whether to
match any or all of the criteria you specify, and then use the “Add” and “Delete” buttons to create a specific search.
Enigmatic prophecies, for example, are well received by characters that match any of the terms “Merits contain
Oracular Ability” or “Flaws contain Nightmares.”



Active Recipients. At the left is a list of all the characters who will currently receive this rumor, based on the search
you specify below. It only lists active characters for the sake of brevity, but if your chronicle reports include inactive
characters, they will not be excluded. Select a character name and click “Show Recipient” to bring up its character
sheet.

Writing Influence Rumors
Influence rumors are similar to general rumors, above, but instead of one rumor they each encapsulate ten. Each level of each
rumor goes to those characters who possess at least the associated number of Traits in Influence. Hence, each level of an
Influence rumor has its own Affected By list, Rumor text and Active Recipients list, but no editable search.
Beneath the title and date of an Influence rumor are ten buttons labeled one through ten. Clicking any button displays the
rumor associated with that level of the Influence. If an asterisk (*) appears on the button, it means no rumor has yet been
written for that level.
A caption above the ten buttons informs you of the highest level of that Influence among active characters in your game. If
you write rumors above that level, nobody will get them. The option to write all ten levels remains for those Storytellers who
like to be thorough.

Example
Actions and plots are complete: all that remain to write the rumors, the main means by which most of your faerie court will
learn about what’s happening at the school.
First you see to the custom rumor you created, called “Schoolchildren.” It begins by going to the ears of all characters, but
you want only the childlings of the game to get it. You click “Add Term” and provide the term “Seeming equals childling.”
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Looking to the left, you find that this rumor has been affected by the Dress Code plot. For the text of the rumor you describe
the rejoicing among the children at school that they won’t have to wear stuffy uniforms quite yet.
Next you decide to work on the Influence rumors. You choose Underworld Influence and start writing at level 1. You see that
this level has been affected by Sally Sluagh’s Contacts action. What was that about? You double-click the link and refresh your
memory about Sally’s loose-lipped contact. You let leak word of Mrs. Grabowski’s embezzling ways into the criminal
underground.
You read at the top of the Underworld Influence window that the highest level of the Influence among active characters in
your game is 1. You decide that writing more rumors would be a waste of time and move on.
You continue, writing up the last two weeks’ worth of intrigue through hearsay and suspicion, until all your Rumors for the
upcoming game session are finally marked Done. Your work is finished at last! Your players are internet-savvy, so you figure
you’ll generate a batch of Action and Rumor Reports and e-mail them all out before game...

Printing, Saving and E-Mailing Character Sheets and Reports
All the information Grapevine organizes is of limited use to a Storyteller if it remains in the game file. That’s where printing,
saving and e-mailing documents come in. Grapevine offers literally dozens of different character sheets and reports in three
different formats. This chapter describes how to select exactly the kind of output you want to create.
To begin, click the “Sheets & Reports” menu and choose “Print,” “Save to File” or “E-Mail.” The corresponding window will
load, selecting by default a report suited to the data you were previously viewing. If you are looking at a character sheet, for
example, choosing to print will load a window prepared to print that specific character sheet. Choosing to save to file while
viewing a list of rumors will load a window ready to save a Master Rumor Report for what you were viewing.

Choosing a Report
At the top of the window appears a dropdown list of the kinds of sheets and reports available. Choose from the following
possibilities:













Character Sheets. The staple of every MET game, these documents describe individual characters in detail.
Action and Rumor Report. A document describing the actions a character takes and the rumors she receives for a
given game date.
Character Equipment Report. A document describing all the items and rotes a character has.
Character Roster. A listing of the characters in the game.
Experience History. A listing of entries in a character’s experience point history.
Game Calendar. A summary of game dates.
Item Cards. A document describing the individual items you select, instead of describing all items belonging to one
character as in the Character Equipment Report.
Influence Report. A detailed report of all the Influences in your game and who holds them.
Location Cards. A document describing the locations you select.
Master Action Report. All the character actions you select, compiled into a report that gives a detailed picture of
what characters are doing in their downtime.
Master Rumor Report. All the rumors you select, compiled into a full report of the gossip flying around your game
world.
Merits and Flaws Report. A listing of all the Merits and Flaws of the characters you select.
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Player Point History. A document that includes a player’s contact information as well as a listing of her player point
earnings.
Player Roster. A listing of the players in your game.
Plot Report. A compiled report of all the plots you select, including recent plot developments.
Rote Cards. A document describing all the individual Rotes you select, instead of only those belonging to a certain
character, as in the Character Equipment Report.
Search Report. A report of the characters that meet the criteria specified in a search.
Sign-In Sheet. A listing of characters and players you can use to record who attends the night’s game session.
Statistics Report. A bar graph showing the outcome of taking statistics on a selection of your characters. It also lists all
the characters who make up the statistics.
Vampire Status Report. This report describes all Status Traits and boons currently in play among the Vampires of the
game.
Choose Template... This selection prompts you for a template file to open. Template files are the blueprints for
Grapevine output: see “Templates” in this chapter and “Customizing Character Sheets and Reports” in the
“Customizing Grapevine” chapter to learn more about templates.

On the right side of the window is a frame labeled “Format,” under which appears three options:






Rich Text (RTF). Rich Text is a simple word-processing format. Saving documents in RTF format creates files that can
be read and edited by WordPad or MS Word. RTF is not as nice-looking as HTML, but Grapevine can print it itself,
even controlling the margins and page orientation given the right template. RTF documents are sent as attachments
when distributed by e-mail.
HTML. HTML is the format used by web pages on the internet. It produces the best-looking output of the three
options. Saving documents as HTML provides an easy way to put game information on your game website. Grapevine
can only print HTML using the default web browser on your computer. HTML is an easy format to send through
e-mail.
Plain Text. This is the simplest of the three formats. Plain text documents aren’t particularly pretty, but being small
and simple they are well-suited to being e-mailed: any e-mail program in the world will read them. You probably don’t
want to print in plain text format unless you have a truly ancient printer.

Selecting What to Generate
Having chosen a document type and a format, you must next choose what data Grapevine includes in the output.
At the top of the window, select the game date for which you want to create the sheets or reports. You may also enter a date
here by hand.

Selection Tabs
The tabs that appear on the window change depending on what kind of report you select. On any tab listing characters,
players, items, rotes, locations, actions, plots or rumors, you should select the entities you want to include in your output by
clicking their names in the list. Selected entities will appear highlighted. Only those that are selected will be figured into the
output.
Several buttons may appear that assist with the selection process:


Select All. Selects everything in the list.



Select None. Deselects everything in the list.
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Select Only. For players and characters, this selects all data that is matched by the search selected in the dropdown
list below the button.



Select Same Date. For actions and rumors, this selects the other actions or rumors that share a date with the
selections.



Select Same Name. Also for actions and rumors, this selects the other actions or rumors that share a character name
or title with the selections.

Searches & Statistics Tab
This tab appears only if you have chosen to report the results of a search or game statistics.

The Search dropdown and the option buttons beside it control which characters are queried for the report.

The Statistics options, which appear only for Statistics Reports, are identical to those used in the Statistics window. See
“Statistics” in the “Working with Characters” chapter for more information on using these. Most likely you will want to first
create the statistics using the Statistics window itself, and then by clicking one of the output options, this window will load
with the values you had just been examining.

Dates & Options Tab
This tab controls the range of dates included with certain reports and whether character sheets include additional data.

Use the “Date Range” dropdown list to choose the extent of a game calendar or an experience history or to choose what Plot
Developments are listed in a Plot Report. The “Chronological Order” and “Reverse Order” options control whether the dates
are listed earliest-to-latest or vice versa.

Depending on the report you’ve selected, other options may appear on this tab: Notes, Histories, Actions, Rumors,
Equipment, Rotes and/or Locations. Selecting one of these options will include the corresponding data with the document;
deselecting the option will exclude that data. In this way you can include a character’s actions and rumors with his character
sheet, or hide sensitive notes information from appearing in a document.

Up to three formatting options may also be available:



Conceal all text marked ST Only. This controls whether text appearing between [ST] and [/ST] tags (by default)
appears in the output. (See “General Settings” in the “Setting up your Game Information” chapter for more on these
tags.)



Allow HTML tags in text. If you have chosen an HTML template, this option appears: selecting it controls whether
HTML tags in places like the Notes field are applied to the output, or are displayed literally.



Save output to file and print with associated Windows program. This option appears if you are printing your output.
If selected, Grapevine will not print your output directly: instead, it will save the output to files, and then it will ask
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Windows itself to print each. Templates created in MS Word, with RTF formatting too complex for Grapevine to
understand, benefit from this feature: Windows will send the RTF to MS Word to be printed.

Printing
If you are printing RTF or Plain Text documents, choose the number of copies you want and use the “Printer Setup...” button
to choose your printer. Then click “Print” to begin the job. A progress bar will appear at the top of the window to inform you
of the progress Grapevine makes sending the information to your printer.
If you’re printing HTML, the work is done through your computer’s default web browser. Clicking “Print” will create the HTML
output and then load it into your browser, where (if you have JavaScript turned on) a print dialog will automatically prompt
you to print the document. You may have to adjust the print settings of your browser for best results. In particular, make sure
your browser supports CSS style sheets. Adjusting the margins (one-inch top and bottom margins are best for item cards),
removing headers and footers, and instructing your browser to print background colors may be other changes you want to
make to your browser’s settings. Consult your browser’s help to learn how.

Saving to Files
A single “Save” button will begin the job of saving your output to files. If you are only saving a single document, Grapevine will
prompt you for a filename. If you are saving multiple documents, Grapevine will prompt you for the folder in which to save
them all. You may then specify whether you want to be prompted before any file is overwritten, or use the “Save Files
Individually” button to specify a location and filename for each of them.

Sending E-Mail
Keep your players informed without subsidizing the ink-cartridge industry by sending sheets and reports through e-mail.

About SMTP
Grapevine uses a method of sending e-mail called Simple Mail Transfer Protocol (SMTP). Sending e-mail through SMTP
requires the internet name or address of a SMTP server, which is a computer whose job it is to route such e-mail messages
through the Internet. An SMTP server usually requires a valid username and password to use.
If you pay an Internet Service Provider (ISP) for your internet access, it’s likely that you get SMTP service from them. Consult
your ISP documentation or contact them directly to find out.
If your computer is set up to use an e-mail program like Outlook, Eudora or Communicator, your SMTP server information may
already be specified there. Look for your SMTP settings in these places:


Microsoft Outlook 2002 (XP). Under the Tools menu, select E-Mail Accounts. Select View or change existing e-mail
accounts, and click Next. Select your e-mail account and click Change.



Microsoft Outlook 2000 / Outlook Express 5 or 6. Under the Tools menu, select Accounts. Select your e-mail account
and click on Properties. Click on the Servers tab.



Eudora 5.1 and 5.2. Under the Tools menu, select Options. Select Sending Mail under the category list on the left side.



Netscape 7. From the Window menu, select Mail & Newsgroups. Select your account and click View settings for this
account in the right-hand pane. Then select Outgoing Server (SMTP) in the left pane.
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Netscape 6. Under the Edit menu, select Mail & Newsgroups Account Settings. Click on Outgoing Server (SMTP) in the
left side list.



Netscape Communicator 4.5 – 4.7. From the Edit menu, select Preferences. Under the Mail & Newsgroups in the left
category list, select Mail Servers.

Unfortunately, free web-based e-mail services like Hotmail and Yahoo! usually do not provide SMTP service to their users. If
you only get e-mail access through the web – and your ISP doesn’t give you any SMTP service – you will probably be unable to
use the e-mail features of Grapevine. Sorry!

E-Mail Setup
Your first step is to supply Grapevine with the SMTP information it can use to send e-mail. You can reach the setup dialog by
clicking “E-Mail Setup” from the output window. This dialog will also appear each time you try to send e-mail without having
provided valid setup information.

The e-mail setup window requires the following information:



SMTP Server. Here, enter the name or IP address of your SMTP Server.



SMTP Port. Most servers use port 25.



Account E-Mail Address. This is the e-mail address from which you are sending messages.



User Name and Password. This is the name and password you use to access your SMTP service: it is usually the same
as your e-mail account name and password. Some SMTP servers do not require these at all.

Checkmark the “Remember Password” box to have Grapevine remember your password for future uses of the program on
this computer. If it is left unchecked, Grapevine prompts you for this information the first time you send e-mail each time you
run the program.

Click the “Test E-Mail Settings” button to send yourself a test e-mail message. It should appear in your e-mail Inbox quickly.
Grapevine will alert you to any errors it detects, such as an incorrect username and password.

E-Mail Addressing
After selecting the sheets or reports you want to e-mail, click the “E-Mail” button to open the addressing window. This
window allows you to specify exactly who your output will reach, and how it looks when it gets there.

A number of fields appear at the top of this window:



Sending. The type of sheets or reports you are sending out.



From. The address you are sending from: this is specified in your e-mail setup.
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Reply To. This is the address that will receive replies to the messages you send.



Subject. This is the subject line created for each message. If the tag [Name] appears here, it will be replaced in each
message with the name of the character or player whose sheet is being sent.

Below these fields are a number of tabs:



Send To, CC, and BCC. These tabs control those two whom the message is sent (and how it is sent), just as with all
e-mail. If a checkbox appears labeled “Send to Players of Characters Selected for Output” or “Send to Players Selected
for Output,” ensure it is selected to e-mail each individual person the sheets or reports specific to him or her. The list
on the left contains other additional recipients chosen from the list at the right. Use the leftward arrow to add an
address or group of addresses to the recipients; use the rightward arrow to remove them.



Message. Text you type here will be affixed to the beginning of the e-mail message(s) you send.



Attachments. Use the “Add” and “Remove” buttons here to attach additional files that will be sent with the
message(s).

Double-check all your recipients, message text and attachments before you click “Send.” Once you do that, Grapevine
immediately sends the e-mail – and if you have a large game, that can be a large amount of data. It’s also disastrous if you
send secret information to the wrong people, so take care!

Templates
Grapevine’s selection of reports and sheets is extensible. If you’ve created custom versions of the default sheets, or if you’ve
created a new kind of report entirely using the template language, you can add it to Grapevine from the Templates tab.
(For more information about customizing template files, see “Customizing Character Sheets and Reports” in the “Customizing
Grapevine” chapter.)
At the left of the Templates tab is a list of all the sheets and reports in your game. You can add a new entry by clicking the
“Add” button and specifying a name, or you can delete an entry by selecting a name and clicking “Delete.”
Clicking a name will display the template files associated with it to the right. There is one file association for each format: RTF,
HTML and plain text. Clicking the Open File icon beside any filename opens a file selection dialog where you can specify a new
template file for the given format of the chosen report.
All Grapevine’s template files are by default located in the Program Files\Grapevine\Templates folder. They’re grouped into
further subfolders: RTF, HTML and Text.

Customizing Grapevine
No tool, no matter how complete, can ever be perfectly tailored for every LARP. Grapevine attempts to compensate for that
fact by giving you ways to customize its environment. Editing the Grapevine Menus allows you to make available custom
Disciplines, Abilities, clans, Merits, Flaws – just about anything – for the character sheets you maintain. Editing the Grapevine
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Template files allows you to customize the program output, providing your players with character sheets and rosters suited
specifically for your game.

Editing the Grapevine Menus
Choose “Grapevine Menus” under the “Game” menu to display the window in which you can customize the menus from
which you build characters in Grapevine. You’ll see the name of the menu file above three tabs: “File Information,” “Menu
Items,” and “Menu Tools.”
On all tabs, you will see a listing on the left of the menus in Grapevine. Beneath it is a dropdown box describing the subset of
menus to include in the list: “General Menus” lists the menus common to most characters, twelve racial categories list menus
specific to each character type, and “All Menus” lists every menu in the program. Double-clicking any menu name enters the
menu, listing its contents. Inside the menus, double-clicking “(back)” takes you back to the top level, while clicking any other
menu entry displays its details on the right.
Click the File Information tab to see information about the current menu file. This is a special Grapevine Menu (.gvm) file,
separate from your game file, that stores the menu structures you use to build characters. The default menu file is “Grapevine
Menus.gvm,” which contains all the Traits and powers used by most MET books, favoring games using revised rules.
On the tab you will see the full path to the file and its description. The description is editable in case you want to save your
own version of the file. On this tab are also two buttons:


Load File… This button prompts you to browse for the Grapevine Menu file that this game will use for its menus.



Merge/Update Menus... This button prompts you to select another Grapevine Menu file or a Grapevine Menu
Update (.gvu) file. Grapevine merges the content of the selected file with your current menus, bringing your menus in
line with those of a friend. A dialog box appears asking you to press “Yes” for an aggressive merge and “No” for a
conservative merge. The difference between the two styles is how they resolve differences between your menus and
the incoming file: aggressive resolves the differences in favor of the newcomer, while conservative fully preserves all
your existing menus. After the merge, you may view the file MergeLog.txt to see the changes described.



Save Menus. This button saves any changes you’ve made to the current menu file.



Save Menus As… This saves the current menus to a new filename you provide.

The second tab, Menu Items, is where you can make changes to the structure of the menu itself. Five buttons are at the
bottom of this tab:


Delete. Delete the selected menu or menu item. You will be prompted for confirmation. If you delete a menu, you will
delete all the items in it.



New Menu. Add a new menu.



New Menu Item. Add a new menu item to the current menu.



New Submenu Link. Add a new submenu link to the current menu. Submenu links are explained below.



Include Menu. Include the contents of another menu in the current menu. Menu inclusions are explained below.

Clicking an item from the display at left selects that item. When a new item is created, it is automatically selected. A different
set of editable fields appears for each type of item:
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Menu. Menus have six fields:


Name. The name of the menu. This must be unique.



Category. The category in which to classify the menu.



Alphabetized. Whether or not this menu is alphabetized. If it is alphabetized and you uncheck this property, a
dialog box will appear to confirm your decision to alphabetize the menu.



Negative. Whether or not costs in this menu are negative, such as with Negative Traits and Flaws.



Add Note with Item. Whether to include an item’s note with the item when it’s added to a character.



Required by Grapevine. If this is checked, it means that Grapevine directly accesses this menu from a character
sheet. The menu is protected against being deleted or having its name changed.



Display. Choose the way items in the menu should be displayed.

Menu Item. Menu items have three fields:


Name. The name of the item, such as “Brawny” or “Investigation.”



Cost. The cost of the item. This may be a single number or a range such as “1 to 3” or “2 or 4”.



Note. The note with the item. Traits tend to have notes indicating their category (such as strength, charisma, etc.)
while powers tend to have notes indicating their level (basic, intermediate, etc.).

Submenu Link. This creates a submenu of the menu in which it appears. The contents of the submenu are the
contents of the linked menu.


Name. The name of this submenu. It will appear in the menu with a colon following it.



Linked Menu. The menu to which this submenu is linked. When you choose this submenu from a character
window, it will load the menu that is linked here.



Go To. Click this button to jump to the linked menu.

Menu Inclusion. When a menu includes another menu, the contents of the second menu are mixed in with the first.
All properties of the first menu, such as alphabetization, are retained; properties of the included menu are ignored.


Name. The name of this menu inclusion. It will appear in the menu with a plus sign following it.



Included Menu. The menu whose contents are to be included in this menu.



Go To. Click this button to jump to the included menu.

If you have selected a member of a menu that is not alphabetized, up and down arrows appear for adjusting the positioning of
an item within the menu.
The last tab, Menu Tools, makes the following functions available:


Find. Enter the text you’d like to search for in the text field, then use the option buttons to determine if you’d like an
exact or partial match. Then click “Find” to jump to the next match for that item in the menu.



Create Five-Power Menu. Click this button to automatically create a new ordered menu with two basic powers, two
intermediate powers, and one advanced power. All costs and notes are prepared; you need only to supply the name
of the menu and its menu items.
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Confirm Deletions. Uncheck this box to disable the pop-up dialog that confirms you want to delete items.

Customizing Character Sheets and Reports
Arguably one of the most powerful features of Grapevine is the ability to customize its output, such as character sheets and
character rosters. You may want to do something as minor as add the name of your Chronicle somewhere on each character
sheet, or you may want to do something as complex as creating a report of the renown of all werewolves with Pure Breed in
the game. While it can’t do everything, Grapevine has flexible and varied output capabilities.
Template files are the blueprints Grapevine follows to construct its sheets and reports. You can find these files in subfolders
under the Program Files\Grapevine\Templates folder.






The RTF folder contains Rich Text templates. While these can be viewed and edited in either the simple WordPad
program or the more complex MS Word, using WordPad is recommended. Grapevine cannot understand some of the
features that MS Word incorporates into an RTF file.
The HTML folder contains HTML templates. These can be viewed in any web browser, and edited in either a text
editor like Notepad (for those who know HTML) or in an HTML editor like FrontPage, Dreamweaver, or even MS
Word.
The Text folder holds plain text templates. These can be viewed and edited in plain text editors like Notepad.

Upon viewing a template, right away you notice it doesn’t look exactly like the character sheet or report that it generates. A
template is littered with keywords that tell Grapevine where to insert information into the file, and what to do when there’s
more than one value to insert. A keyword is a word appearing between square brackets [ ], sometimes followed by a space
and a parameter or two – additional values separated from the initial keyword by a space.
The simplest kind of keyword is one that Grapevine replaces with information. In the template Vampire.html, for example, the
keyword [Clan] appears in one cell of the table: when Grapevine reads the template to turn it into a character sheet, it
removes the text [Clan] and replaces it with the actual clan of the Vampire being printed.
Other keywords set certain options in the character sheet. In an RTF template, the keyword [Landscape] will instruct
Grapevine to print the sheet in a Landscape orientation. In a plain-text template, the keyword [Wrap n] will turn on word wrap
to a length of n characters. These keywords affect the output but never appear in it.
The keywords most challenging to understand are those that divide the template into sections. These keywords appear in
pairs: [repeat] and [/repeat], [option topic] and [/option], [report topic] and [/report], and others. When Grapevine reads a
section, it follows special rules to decide what to do with the part of the template that appears between the keywords:




[repeat]. A section between [repeat] and [/repeat] is copied and pasted over and over until the data keywords it
contains return no more new values. [repeat][Physical][Mental][/repeat] , for example, would write a Physical Trait,
followed by a Mental Trait, followed by a Physical Trait, and so on, until there were no more Physical or Mental Traits
to write.
[option topic]. A section between [option topic] and [/option] typically corresponds to the options you can select on
the Dates & Options tab of the output window. [option] sections are only used inside character sheets or special
character reports. The value of the topic parameter makes each [option] section behave a bit differently. [option
Notes], for example, simply marks a section of the template that should be removed if the Notes option is not
selected. [option Items] is more complicated: the text inside its section repeats for every item in the character’s
equipment list, making it possible to include a character’s detailed item cards on his sheet.
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[report topic]. A section between [report topic] and [/report] iterates through a set of entities you select in the
output window. A [report characters] section can create specialized character rosters, a [report players] section can
create specialize player rosters, a [report plots] section will go through all the selected plots, and so on. The text
inside the section is repeated for each entity until there are no more to report.

The art of placing the right keywords in the right places is best learned through experimentation. Try making small changes at
first, and as you get the hang of it begin to try more complex experiments. Make a backup copy of the template you want to
edit. If you edit the original, you’ll see your changes the next time you print or save the corresponding document. If you create
an entirely new kind of sheet or report, you can get quick access to it by choosing “Choose a Template...” from the output
window dropdown, or you can go to the Templates tab to add it to your game file permanently.
You may also find these resources helpful for template editing:


The Template Keywords Reference included with the Grapevine installation. This document should be included in the
Grapevine group accessible from your Windows Start Menu. It’s stored in the Program Files\Grapevine\Templates
folder.

Additional Program Features
Window Maintenance
The Window menu provides a few basic tools for working with Grapevine windows.


Show Toolbar. Uncheck this option to hide Grapevine’s graphical toolbar.



Maximize Current. The shortcut for this command is F11; use it to maximize a sizable window to the full extent of the
Grapevine desktop.



Minimize All. Minimize all the windows on the Grapevine desktop.



Restore All. Restore all the minimized windows on the Grapevine desktop.



Close All. Close all the windows on the Grapevine desktop.



Current Windows List. All the windows on the Grapevine desktop are listed here. Select one to jump to that window.
If more than nine windows are open, a “More Windows...” option will open a dialog with the full list.

Help
The Help menu directs you to information about the Grapevine program.


Grapevine Website. This will launch the Grapevine website in your web browser.



Grapevine Help Pages. When this guide is available online, this will direct your web browser there. In the meantime,
this guide isn’t half bad, eh? You’ve read all the way to the end, after all!



About. Learn more about the Grapevine program, about me (Adam Cerling), and about the people who helped make
it all happen.

- 39 -

Quitting the Program
Choose “Exit” from the File menu to quit the Grapevine program. If you have made changes to your game file or to the menu
file, you’ll be asked whether you want to save those changes.

- 40 -

